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Disclaimer

July, 2015

Disclaimer: Synercon Technologies does not warrant the completeness and accuracy of the in-
formation produced by its software. While best efforts by industry experts have been made to
generate information from raw digital data, there may be untested variations, add-on packages,
errors or mistakes due to the large amount of data being processed. It is the sole responsibility
of the user of the Synercon Technologies systems and Software to determine the fitness of the
information provided by the Software for any particular application and for each individual
case. Synercon Technologies cannot warrant any loss of functionality due to the lack of reliable
network connection to the Synercon Server. The user is responsible for establishing a reliable
Internet connection for the Software to fully function. Synercon does not warrant that the
Equipment and/or Software will be compatible with each vehicle model. Electronic compo-
nents installed on the vehicles may be replacement parts and not programmed to match the
implementations of the Equipment, hence Synercon cannot warrant the existence or accuracy of
the data recorded on the vehicle or the existence of a fault-free environment. The information
provided by the Software is to be used only by vehicle manufacturer product experts, engineers,
professional accident investigators and traffic crash reconstruction specialists. The user should
agree that the use of the Software and Equipment requires an appropriate level of skill and
competence. Since Synercon cannot warrant that the Equipment will create an environment
that does not set new fault codes in the vehicle’s electronic control module(s) which may alter
the digital data contained therein, the User assumes all risks in using the Equipment for the
purposes of preserving a digital record. The user agrees to verify the Equipment is working
according to this manual before using it to support an investigation or reconstruction. Synercon
Technologies, LLC assumes no liability for incidental, consequential, special or punitive dam-
ages, including but not limited to lost profits and loss of data. The user agrees to indemnify and
hold harmless Synercon Technologies, LLC, any of its employees, owners, officers, and managers
from any legal action involving the use of the data produced or stored by the software.
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About this Document

This manual is intended to teach the operator the features and use of the Forensic Link
Adapter (FLA). This is manual is designed as a teaching tool, rather than a reference guide.
There are many acronyms and terminology used throughout this document; the reader is advised
to familiarize themselves with the Terminology section before reading. It is suggested that
operators examine this document entirely before using the FLA to help ensure that the most
data, and the most accurate data are retrieved.
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Part I

Introduction to Synercon Products
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1

Synercon Products

There are four main Synercon Technologies products. They will be referred to in the rest of
this manual, so readers are advised to familiarize themselves with these components to better
understand the rest of this manual.

The 4 Synercon products are

� The Forensic Link Adapter (FLA)

� The FLA Preview

� The FLA Portal

� The Smart Sensor Simulator (SSS)

All of these products work together to create an easy, secure system to extract data from
heavy vehicles. or an RP1210 interface to allow the operator to use OEM software.
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1.1 The Forensic Link Adapter (FLA)

The FLA is the device used to extract data from Engine Control Modules (ECMs). The FLA
is designed to extract data from ECMs in a forensically secure way. The FLA uses the SAE
J1939 and SAE J1587 standard protocols to communicate with ECMs. The FLA can extract
data from ECMs by itself for select ECMs, meaning there is no need to carry a computer with
OEM software to obtain data. For ECMs that the FLA cannot directly support, the FLA can
be an RP1210-compliant diagnostic connector. This allows the operator to use OEM software
to collect data through the FLA.

FLA Features

Forensically secure data collection

Stand alone data collection for select ECMs

Easy to read OLED screen

Simple and durable two button interface

Built in GPS antenna
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1.2 The FLA Preview

The FLA Preview provides an expanded interface to the FLA while out in the field. The FLA
Preview is used to preview reports while in the field to confirm the operator has the data they
wish to obtain. The FLA Preview is a website hosted by each FLA. It is accessed by entering
the IP address of the FLA into a web browser. The FLA Preview can be accessed without an
Internet connection, though the computer on which the FLA Preview site is accessed must be
on the same Local Area Network as the FLA.

FLA Preview Features

� Ability to preview data in field

� Ability to download event data from select ECMs

� Ability to view old data that has been uploaded
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1.3 The FLA Portal

The FLA Portal is also referred to as Synercon’s Servers. It is located at the URL https:

//fla.synercontechnologies.com. Data collected from the FLA is uploaded to this site, and
operators are able to view full reports there.

FLA Portal Features

� View full reports with all available event data

� View the FLAs last known location

� Check subscription status

6
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1.4 The Smart Sensor Simulator (SSS)

The SSS simulates sensors of a typical vehicle for ECMs. It is used when the FLA cannot
communicate with the vehicle due to damaged wiring. The SSS reduces the chance the ECM
will throw a fault compared to a standard calibration harness. SSSs are specific to a type of
ECM.

SSS Features

Reduces chances of throwing new faults during download

Provides reliable communications to ECMs

Can be brought to the field to eliminate the need to remove ECMs from vehicles.

7



2

Getting Started

Congratulations on purchasing the only heavy vehicle scan tool purpose-built for examining
vehicles in a forensic or investigative context. This section provides a guide to getting the FLA
System set up for the first time.

2.1 What is Included with the FLA

2.1.1 The Contents of the FLA Case

The FLA Case has everything operators need to collect data from heavy vehicles. The FLA
case has the following items:
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2.1.2 The FLA Portal and FLA Preview

The subscription to the TruckCrypt software allows operators to access the FLA Portal and
FLA Preview. These will be discussed in more detail in sections 5 and 6.

2.2 Register as an Operator

The fla-admin should send you an email to invite you to be an operator for your FLA on the
FLA Portal. The fla-admin email is initiated by the Organization administrator inviting a new
operator. For more details, please see Chapter 11. It will be necessary to have a FLA Portal
account to view any data you collect with your FLA.

2.3 Operating the FLA

The FLA has a 4x20 character LCD screen, along with two buttons to allow the user to
interact with the device.

2.3.1 Interacting with the FLA

There are two general types of screens the FLA will display.

Prompt Screens

The prompt screens will have one or two
options on the last line, corresponding to
the button on that side of the FLA.

Working Screens

The working screens will not have an op-
tion on the last line, but usually a per-
centage bar. During these screens, the
FLA is performing the operation displayed.
NOTE, during these screens the RED
button can cancel the current task.

2.4 Familiarize yourself with the FLA

After the operator has performed these steps, the FLA is ready for field use. To maximize
the validity and completeness of data collected, the operator is advised to continue reading this
manual. After the user is familiar with this, the best way to get comfortable with using the
FLA is to practice. This manual, and the other supporting documents will help guide operators
through the data collection and review process.
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3

Using the FLA

The FLA is a powerful data extraction device, with many features. This section will teach
the reader about the FLA, how to use it, and the features of the FLA.

3.1 Display Screen Menu System

Almost all of the features of the FLA can be accessed through the main menu. The only
two functions that are not available are the FLA Support Mode, and previewing data, which
are solely available on the FLA Preview. Once the FLA boots, the device will enter the main
menu, which contains the most used functions, such as running a scan, and uploading data.
The below figure describes the layout of the FLA menu system.

3.2 Menu Screen Descriptions

The menu system of the FLA is dynamic: it will only give the operator the option to perform
an action if the FLA detects the action is possible. For example, the FLA will not allow the
operator to initiate a vehicle scan if the FLA does not detect any network traffic.
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3.2.1 Main Menu

Title Screen

This is the first screen the FLA will dis-
play when it finishes booting. This screen
provides the user with an overview of the
FLA’s state.

Shutdown Screen

This screen will allow the user to safely
shutdown the FLA.

Upload Data Screen

This screen allows the operator to upload
data on the FLA to the FLA Portal. If
the Upload option is not available, see the
troubleshooting section.

View Faults Screen

This screen allows the operator to view ac-
tive faults on the J1939 network.

GPS Screen

This screen displays the last available GPS
coordinates, and the FLA system time
when they were received.
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System Configuration

This screen allows the user to enter the sys-
tem configuration menu of the FLA.

3.2.2 System Configuration Menu

Update Software Screen

This screen allows the operator to update
the FLA software to the latest version. If
the update option is not available, see the
troubleshooting section.

DHCP Service Configuration Screen

This screen allows the operator to enable
or disable the DHCP services for the FLA.

Update FLA System Time Screen

This screen allows the operator to update
the FLA System time. If the Update op-
tion is not available, see the troubleshoot-
ing section.

Change FLA Timezone Screen

This screen allows the operator to change
the FLA system timezone.
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MAC Address Screen

This screen displays the MAC Address of
the FLA, as well as the IP Address.

3.2.3 Menu Screen Dynamic Lines

Certain lines of menu screens are dynamic, and display the status of various components of
the FLA.

IP Address Line

The IP address Line can have the following states:

IP: XXX.XXX.XXX.XXX A valid IP address. XXX can be any number between 0
and 255. An example would be 192.168.2.45

IP: 10.0.0.1 The IP address when the FLA’s DHCP server is activated. See the DHCP
section for more information.

Ethernet Unplugged The FLA cannot detect a live Internet connection. If this screen
persists for more than 60 seconds on a known good Ethernet port, refer to the trou-
bleshooting section.

Finding IP Address The FLA detected a live Internet connection, and is searching for
an IP address. If this screen persists for more than 60 seconds on a known good Ethernet
port, refer to the troubleshooting section.

Vehicle Connection Line

The vehicle connection line displays the status of the vehicle busses. This line can have the
following states:

No Vehicle Net / Check Ign. Key The FLA is not able to detect any traffic on
the vehicle networks. If this screen persists for more than 10 seconds, refer to the trou-
bleshooting section.

CAN Bus only The FLA only detects traffic on the CAN bus.

J1708/1587 only The FLA only detects traffic on the J1708/1587 bus.

CAN and J1708 The FLA detects traffic on both the CAN and J1708 buses.

3.3 Working with the Forensic Link Adapter

This section will explain the basics of using the FLA. This section is is intended for users
with little experience operating the FLA.
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3.3.1 Powering Up

The FLA will begin to boot whenever power is supplied to the device. This can be done in
one of three ways:

1. Using the vehicle connection cable to power the FLA using the battery of the vehicle

2. Using the wall adapter to power the FLA using a wall outlet

3. Using the 12v cigarette adapter to power the FLA, either from a vehicle battery or a
portable battery pack

The FLA can accept power from both the wall adapter or 12v cigarette adapter and the ve-
hicle connection cable at the same time. This is useful of an operator needs to perform several
downloads in the same area.

Once the FLA is finished booting, the de-
vice will display the title screen.

When this screen appears, the device is ready to operate. If the device does not reach this
screen in 60 seconds, see the troubleshooting section of this manual.

Once an investigator has established permission to download the data from a vehicle, the
key needs to be turned to the on (not start) position for the FLA to communicate with the
Electronic Control Modules (ECMs).

The FLA can be plugged into the 9-pin diagnostic connector, which is usually located below
the dash on the left side or to the left of the driver’s seat. If the ECM was removed, then it
should be connected through a Smart Sensor Simulator that emulates a truck.

3.3.2 Shutting Down

Failure to shut down the FLA correctly can cause loss of data. To shutdown the FLA prop-
erly, follow these steps:

1

Scroll to the Shutdown screen, and select
”Shutdown.”
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2

Confirm the shutdown.

3

Wait until the FLA indicates it is safe to
remove power.

4

When the FLA displays this screen, it is
safe to remove power.

3.3.3 Connect the FLA to the Internet

Connecting the FLA to the Internet allows the device to get updates, set the system time,
and upload data to the FLA Portal. To connect the FLA to the Internet, follow these steps:

1. Plug the FLA into a functional Ethernet port using the included Ethernet cable.

2. The FLA should display an IP address on the second line of the title screen, the screen
that is displayed right after the FLA finishes booting.

3. If the FLA displays “Ethernet Unplugged” or “Finding IP Address” for more than 60
seconds, consult the troubleshooting section.

3.3.4 Setting the Time

Once connected to the Internet, the Forensic Link Adapter can synchronize with universal
time using a dedicated time server. This step is only necessary if the time displayed on the title
screen is not the correct time. To correct the FLA time, follow these steps:
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1

Scroll to the System Configuration screen
on the FLA, and select “Configure.”

2

Scroll to the Update System Clock screen,
and select “Update.”

3

Once the FLA retrieves the current time,
it will confirm the new time with the oper-
ator before setting the time. The FLA will
continue to update this time, so the user
does not need to immediately confirm the
time.

3.3.5 Setting the Timezone

The timezone for the FLA can be set without an Internet connection. To set the system
timezone, follow these steps:

1

Scroll to the System Configuration screen
on the FLA, and select “Configure.”

2

Scroll to the Change FLA Timezone screen,
and select ”Change.”
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3

Select ”Next” to view the next timezone,
and select ”Set” to set the timezone

3.3.6 Updating the FLA

Updating the FLA provides the latest software, with the most features and highest chance of
getting the most data. It is good practice to perform an update before downloading a vehicle,
or before going out in the field to download. To perform an update, follow these steps:

1

Ensure the FLA is plugged into an Ether-
net jack, and has an IP address.

2

Scroll to the System Configuration screen,
select ”Configure.”

3

The FLA will now display the Update FLA
Software screen. If the FLA does not
have the Update option, consult the trou-
bleshooting section. Select ”Update.”
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4

Confirm the update.

5

Wait for the FLA to perform the update.
This can take several minutes.

5

When the FLA is finished updating, it will
need to shutdown and be rebooted for the
updates to be applied. Select “Shutdown.”

5

After the FLA has completed the shut-
down, unplug all sources of power, If the
operator wishes to continue interacting
with the device, wait 10 seconds before
plugging in power.

3.3.7 Turning DHCP ON

Enabling DHCP allows the FLA to communicate with computers when an Internet connection
is not present. One example usage is to preview data in the field. Do not enable DHCP services
while the FLA is plugged into an active network, as this may create issues with the network.
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1

Scroll to the system configuration screen.

2

Scroll to the Change IP Settings screen,
and select “Enable.”

3

Confirm the request.

3.3.8 Turning DHCP OFF

Disabling DHCP allows the FLA to communicate with an active network. DHCP is disabled
when the FLA boots.

1

Scroll to the system configuration screen.

2

Scroll to the Change IP Settings screen,
and select “Disable.”
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4

Setting Up the FLA

4.1 In the Office Use

When the FLA is in use at the office, ensure that the DHCP server is off. If left on, this can
cause problems with the network the FLA is connected to.

When the FLA is being used with a foreign network, such as any network that is not your
home or work network, extra caution must be taken. The local site can be accessed by anyone
on the same network. It is not recommended to plug the FLA into an unknown network.

4.2 At Home Use

When the FLA is in use at a home, or another non-commercial site with an Internet connec-
tion, the DHCP server should be turned off. If left on, it can cause problems with the network
the FLA is connected to.
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4.3 In Field Use

When the FLA is being used in the field, the DHCP service may be turned on. This ser-
vice allows the user to connect a computer directly to the FLA using the provided Ethernet
connection. For more information on enabling DHCP services, refer to section 3.3.7.
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5

The FLA Preview

The FLA Preview is a website that each FLA hosts. This allows operators to interact with
the FLA in ways the front panel is not able to support, such as previewing reports.

5.1 Accessing the FLA Preview

Accessing the FLA Preview is done by entering the IP address of the FLA into a web browser.
Please see the requirements section for more information about supported web browsers. As
shown below, enter the IP Address exactly as it appears on the IP Address line.

This will load the FLA Preview main page, shown below.
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This page provides an overview of the current status of the device. The “At a glance section”
will display the number of pending data packages, that is the number of data packages that
have been downloaded to the FLA but not yet uploaded to the FLA Portal, and if there is a
download in progress.

5.2 Using the FLA Preview

The FLA Preview has many uses, including allowing operators to preview data in the field,
download the User Manuals, download RP1210 drivers, and many other useful tasks we will
cover in this section.

5.2.1 View Local Data

Under the View Local Data page, the operator is able to view data on the FLA. There are
two sections to local data, Pending Uploads, and Archived Data. Pending Uploads will show
any data packages that are ready to be uploaded to the FLA Portal.
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This page will give an overview of each pending data package. The value in the OEM data
column will be YES if the FLA was able to recover OEM data for that download, and NO if the
FLA could not. The yellow Archive button will remove the data package from being uploaded,
and move it to the archived section. If an archive is unintentionally archived, the FLA will
have to be serviced to retrieve the data. For more information about servicing the FLA, see
the Service section.

When a download is in progress, the row for that entry will indicate the download is in
progress, and will not provide the “View Data” button. Once the user finishes the download,
the operator can refresh the page, and will see the “View Data” button. For more information
about when a download is finished, and how to perform a download, refer to the Field Guide.

Selecting the “View Data” will provide the user with a preview of the report. This preview
includes all of the standards-based information, the components found, and any identification
information, as well as any in-field non-standards-based previews. Non-standards-based infor-
mation is any data that is provided by OEM software, such as DDEC reports’ XTR files, and
CAT Snapshots. The operator will get a preview of this data here in accordance with the type
of ECM being analyzed. The full reports will be available through the FLA Portal when the
operator uploads the data. Typically, the following will be available:

Preview of DDEC ECMs

If non-standards-based data is collected
from a DDEC ECM, an XTR file will be
available for download.
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Preview of CAT ECMs

If non-standards-based data is collected
from a CAT ECM, a CSV file will be avail-
able containing 5 frames around the trigger
for any quick stop records.

The preview will also contain a SHA 256 Sums file for the operator to download. This file
contains the SHA 256 sums of all data files the FLA has created. The operator can download
this file, and confirm the data uploaded to the FLA Portal was the same data the FLA created.
For more information on SHA 256 sums, as well as recommended use, see the SHA 256 sums
of suggested practices.

The operator can also click on the “Archived Data” button on the View Local Data page to
view data packages that were archived. Data packages that are uploaded to the FLA Portal
are automatically archived. From here the user can access all of the same downloads and
information as when the data package was pending uploading. Meaning, once the data is
uploaded, the user can still download XTR, CSV, or SHA 256 Sum files, as well as any standards-
based data acquired. If the FLA has a large number of archived data packages, the archived
page may take several moments to load.
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6

Using the FLA Portal

The FLA Portal is where operators can view full reports of the data they collected in the
field. Administrators will also use the FLA Portal to manage FLAs, and users.

6.1 Accessing the FLA Portal

The FLA Portal is accessed by navigating to https://fla.synercontechnologies.com/ in a sup-
ported web browser. For a list of supported web browsers, refer to section 15.

The FLA Portal will require the operator to login, using the username and password used
when the operator created the account. Note that BOTH username and password are case-
sensitive.

Once logged in, the operator will be able to view data acquired from the assigned FLA.
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6.2 Using the FLA Portal

For operators, the main use of the FLA Portal is to view full reports. Administrators should
refer to the Administrative Guide for further information about administrating on the FLA
Portal.

Once an operator uploaded a data package to the FLA Portal, the data will be available for
viewing by everyone in the group. A logged-in operator will be able to view all data packages
uploaded to the server.

Selecting one of these reports will open the full report.

The FLA full report has many sections, including those listed in the next sections.

27



6.2.1 Vehicle Information

This section contains any components that responded to a component Identification request.
The VIN, Vehicle Odometer, and Engine Hours will also be displayed under Engine #1 for the
appropriate network. This section also contains the time records from the download, including
vehicle time if available, and time of the last GPS Lock.

6.2.2 Data sections

Data sections, such as Historical Data, Event Data, etc., are sections that contain either
standards-based data, or non-standards-based data. These sections contain all of the data the
FLA has decoded. Due to the wide variety of ECMs, and ECM configurations, these sections
may contain different data depending on the ECM being analyzed.

6.2.3 Nomenclature

This section contains a brief overview of the nomenclature used in the report.

6.2.4 Network Logs

This section contains the logs of all of the FLA’s interactions with the ECMs. These logs are
provided as a means to audit the messages being sent. If the RP1210 passthrough is engaged,
separate logs for any passthrough transactions will be available.

6.2.5 Version Information

This section provides the software versions that were used when the report was generated.
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6.2.6 SHA 256 Sums

This section provides the SHA 256 sums for all of the data files the FLA generated when the
download was performed. These sums are encrypted and sent to the FLA Portal for verification.
The FLA Portal will generate its own SHA 256 sums of the data files uploaded by the FLA.
The FLA Portal will then compare the two, and verify the integrity of the upload.

If there is a SHA 256 mismatch, this may suggest the data has been tampered with.
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6.2.7 Access Information

This section provides an audit of who is currently accessing the report, and the device’s IP
address.
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7

Before Going Out in The Field

Before performing a download in the field, please perform the following steps in order to
ensure the Forensic Link Adapter (FLA) is operating with accurate information. Please note
that this will require a live Ethernet port and a way to power the FLA. The FLA case has an
Ethernet cable, as well as a wall power unit and a car cigarette lighter adapter to power the
FLA.

7.1 Perform an Update

Performing an update ensures the FLA has the latest software. To update the FLA, first
plug the device in and plug in the Ethernet cable into a working Ethernet jack. If you have any
questions about a working Ethernet jack, please contact your department IT services.

1

Once the device boots, scroll to the System
Configuration screen.

2

Enter the configuration sub-menu. This
will take you to the Update Software
screen.

From this screen, select update. A confirmation screen will appear to prevent accidental up-
dates.
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After the update completes, the FLA will require a shutdown. Select ”Shutdown” to shut
the device down before unplugging it. After the device indicates it is safe to do so, unplug the
power supply. After waiting 10 seconds, plug the device in to continue.

If time displayed on the FLA is not correct, the time can be updated through the configuration
menu. As with the update, an Internet connection is required. The timezone of the FLA can
also be changed in the system configuration menu. For more information about setting the
time and timezone, refer to Section 3.3.5.

7.2 Download Appropriate Drivers

The FLA can act as an RP1210 device for using OEM software. This only required if the
ECM being downloaded is not supported. For a list of supported modules, refer to the FLA
User Manual. The drivers for the RP1210 feature of the FLA can be found either at Dearborn
Group’s website http://www.dgtech.com/product/dpa/software/DPA4P_136.zip Or on the
FLA Preview site.

The FLA Preview site is a website that is generated by the FLA. To access it, first ensure it
is powered on, and has an IP address. This can be confirmed by the title screen shown below.

On a computer connected to the same network, type the IP address into a web browser. The
following page should appear.
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From this page, select Download Drivers, and then the Download button. The Download
Drivers page also has testing instructions to verify RP1210 is working correctly. This site can be
accessed without an Internet connection, as the website is generated by the FLA. For connecting
to the site in the field, see section 4.3.

7.3 Manufacturer Software

If the ECM being downloaded is not supported by the FLA, please ensure a computer has
a working copy of the OEM software, and also the RP1210 drivers discussed in the previous
section.
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8

Downloading ECMs With the FLA

Downloading ECMs will require the FLA, the vehicle to download or the ECMs and a Smart
Sensor Simulator, and permission to perform the download.
These are the general steps to perform a download. Some screens may be different depending
on the type of ECM being downloaded.

1

Start at the Title Page and select scan to
begin the scan. If the scan option is not
present, refer to the troubleshooting sec-
tion.

2

The device will ask if the operator has
sufficient permission to perform the scan
and collect data from the vehicle. When
the operator continues, this action is time-
stamped and rendered with the reports.

3

The FLA will first listen to the networks
and build a list of all of the components on
each network.
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4

The FLA will then begin the standards-
based scan, collecting information such as
ECM Component Identification, Mileage,
etc.

5

The FLA will display the Component Id of
the engine, as well as the first 15 characters
of the VIN. The full VIN will be in the re-
port. Selecting Continue will continue the
scan, Back will cancel the scan.

7

The FLA will attempt to detect a sup-
ported ECM to extract proprietary data.

8.a

If the ECM is supported, this screen will
ask if the user wishes to collect non-
standards based data. See Section X to
extract non-standards data with the FLA.

8.b

If the ECM is not supported, please see
chapter 9 to extract data with OEM soft-
ware.
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8.1 Supported ECMs

The FLA can extract more data from supported ECMs, such as event data and other non-
standards based data. For a list of supported ECMs, refer to the FLA User Manual. Continuing
from screen 8.a from the previous section, select ’Get Data’ to continue the non-standards based
data extraction. During the extraction, the FLA will display the current status of the extraction.
The extraction make take some time, so please wait for the FLA to indicate it is finished. Once
completed, the FLA will ask the user if they wish to enable RP1210 mode, or continue to the
upload screen. If desired, the FLA can also enable RP1210 mode after performing an extraction.
See section 3.2.1 for more details on uploading data.

The FLA can obtain additional information from the following ECMs

� CAT

– ADEM 3

– ADEM 4

� DDEC

– DDEC IV

– DDEC V

– Some DDEC VI

– Some VCU/PLD
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9

Downloading ECMs with OEM Software

If the FLA is not able to extract data from the ECM, the user can enable RP1210 mode
and use the FLA as a passthrough device with the appropriate OEM software. There are
two protocols used to communicate over a heavy truck: 1) CAN/J1939, and 2) J1708. These
modes are needed to make use of the DG RP1210 embedded device used to communicate with
Manufacturer’s software.

9.1 Downloading Cummins ECMs

9.1.1 PowerSpec Download Protocol

1. Turn the ignition key to the on position (if it is not already on), but do not start the
engine.

2. Plug in the FLA to the diagnostic connector. Ensure it powers on and boots.

3. Perform a Standards based download using FLA Diagnostics.

4. Enable J1939 Passthrough mode

5. Launch DG Adapter Validation Tool (AVT).

(a) Select the appropriate installed device driver.

(b) Switch the protocol to J1939 in the adapter validation tool.

(c) Click Run Test.

(d) If the Adapter Validation Tool passes the test, then two windows will turn green.
This means the ECM and the computer are connected through the RP1210 De-
vice. If a test fails, review the suggestions output by the Adapter Validation Tool
and try again. It may require shutting down the FLA, unplugging the USB, and
disconnecting the FLA from power. Similarly, the PC may need to be rebooted.

6. Open Cummins PowerSpec.

7. Click on Advanced → Settings and set the Adapter to the DPA4+

8. Click on Connect.
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9. Click Read Data

10. If available:

(a) Press the Fault Codes button and Save the report as a PDF file.

(b) Press the Trip Information button and Save the report as a PDF file.

(c) Press the Feature Settings button and Save the report as a PDF file.

(d) Press the Sudden Decel button and Save the report as a PDF file.

(e) Press the Dataplate button and Save the report as a PDF file.

(f) Press the Duty Cycle button and Save the report as a PDF file.

(g) Press the After Treatment button and Save the report as a PDF file.

11. Exit Passthrough mode by pressing a the Update (red) button on the FLA. If an In-
ternet Connection is available, then the data can be uploaded and archived. Otherwise,
shutdown.

12. Establish Internet connection with the FLA. An IP address other than 10.0.0.1 should
show up on the FLA display.

13. Scroll to the Upload to Server option on the FLA and upload the data to the server.

9.2 Downloading Detroit Diesel ECMs

9.2.1 DDEC Reports Download Protocol

1. Turn the ignition key to the on position (if it is not already on), but do not start the
engine.

2. Plug in the FLA to the diagnostic connector. Record the time shown on the FLA.

3. Perform a Network Scan using the Forensic Link Adapter.

4. Enable the RP1210 network Passthrough mode.

(a) Use J1708 Passthrough mode for DDEC IV, DDEC V, and Pre-2008 Mercedes En-
gines.

(b) Use J1939/CAN Passthrough mode (selected from menu screen on FLA) for all newer
DDEC 10 and DDEC 13.

5. Open DDEC Reports by clicking on the icon on your computer.

6. The Connection Manager may start automatically.

7. Ensure the Reset Time and Reset Trip options are not checked. Take a screen shot of
these features unchecked.

8. Press Extract Data.

9. Once the data is extracted, Select File → Print and print all the data (should be over 30
pages). Print to a PDF file
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10. Close DDEC Reports.

11. Navigate to the DDEC Reports directory to find the recently made .XTR file. (Default
installation is C:\Detroit Diesel\DDEC Reports\Diagnostic\DATA PAGES\ Copy the
.XTR file into your case file directory.

12. Exit Passthrough mode by pressing Exit\Upload on the FLA. Exiting this mode will
compress log files and takes some time.

13. Establish Internet connection with the FLA. An IP address other than 10.0.0.1 should
show up on the FLA display.

14. Scroll to the Upload to Server option on the FLA and upload the data to the server.

9.2.2 Diagnostic Link Download Protocol

This protocol is to support data from DDEC III, DDEC IV, and DDEC V control modules.
These modules primarily communicate over the J1708/J1587 network. This protocol was writ-
ten for verison 6.50. Other versions may have a different method.

Setup

Before proceeding, please be sure to not automatically reset the time.

1. Open Diagnostic Link.
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2. Select Options and deselect Allow automatic setting of date/time
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3. Set the Local Communications Interface to the DG DPA4 Plus.

4. Restart DDDL 6

Download

1. After obtaining data with the Forensic Link Adapter, connect to the ECM with the
RP1210 mode in J1708 and connect the USB cable to your computer.

2. Be sure the the ignition key is still in the the on position, but do not start the engine.

3. A popup Welcome Screen should appear. Press the Retrieve the calibration from the
ECM button.
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4. Download the Engine Configuration Data and Print the data.

5. Retrieve the Calibration Data and Print it from the file menu.
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6. Gather and Print Injector Calibration
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7. Select Audit Trail from the Calibration Menu and then Print.
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8. View and Diagnostics → Fault Codes then File → Print Fault Codes

9. Select Diagnostics and Diagnostic Instrumentation. Select the List tab and then Print.

10. Select Diagnostics → ECM I/O Configuration. This can be printed and saved to a text
file. The text file may be saved to C:\Detroit Diesel\Diagnostic\IOConfig.
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11. Select Diagnostics → Injector Response Times to print.
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12. Select Diagnostics → Maintenance Alert

13. Select Tools → Engine/Trip Data
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14. Take a screen shot of the software verison number from Help → About

9.3 Downloading Caterpillar ET ECMs

This section provides a protocol to use CatET to download Caterpillar ADEM II, ADEMIII,
and ADEMIV engine control modules. These modules are found on C series engines (i.e. C-15,
C-12, C-9, and C-7) and 3126.

9.3.1 Prerequisites

You must have the DG RP1210 drivers installed on your computer. The procedure for obtaining
and installing these drivers is found in subsection 7.2

Caterpillar Electronic Technician (ET) must be installed on your computer. The procedure
described in this section was based on version 2013A.
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Set the preferences in CatET to use the DG DPA 4 Plus, which is the RP1210 device built
into the FLA. This is shown in the following picture.

Setting the Warranty Report Startup helps with the work flow when connected, as seen in
the following picture. These settings will remain from session to session.

It is recommended to create a new data directory for each download to keep track of the
data and not mix it with other information.

9.3.2 Connecting to an ECM

1. Turn the ignition key to the on position (if it is not already on), but do not start the
engine.

2. Plug in the FLA to the diagnostic connector. Ensure it powers on and boots.
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3. Perform a Standards based download using the FLA.

4. The FLA needs to be in J1708 Passthrough mode, which is screen 7. Once the FLA is
in Passthrough mode, it will log and preserve network traffic for a forensically verifiable
record.

5. With the FLA connected through USB, start CatET. The program should automatically
connect to the ECM, as shown in the following picture. If not, then the user can press
F8 to connect once CatET is running.

9.3.3 Warranty Report

1. CatET will automatically ask if you would like to create a Warranty Report. Press Yes
when the following dialog appears. This can also be accessed through the Information
menu.
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2. An information screen will appear. This can be filled out as desired. Leaving the fields
blank may be the best option. Press Next to proceed.

3. Press Yes when asked to download data from the ECM.
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4. The software will download data for the report. The Configuration data takes the longest
time.

5. Once the data is downloaded, press Save to create an XML file.
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6. Keep track of where you save the Warranty Report using the Save As dialog.

7. Record where the file was saved based off the following confirmation:

8. Print the Warranty Report using the Print menu option
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9. Enter Comments that will appear on the header of the report.
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10. The first page of the Warrany Report appears as follows:
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11. Scrolling through the Configuration data will reveal the Quick Stop Rate. If this is set to
0, then there may not be any Sudden Deceleration Snapshots.
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9.3.4 Snapshot Data

1. Select the Snapshot Viewer from the menu options as shown in the following picture:

2. A menu of recorded Snapshots appear. Please select next one and press View Graph.
Taking a screenshot of this dialog box is a good idea to keep track of all the available
Snapshots.
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3. A progress bar will appear.
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4. Once downloaded, select the parameters to graph.

5. The resulting graph will show and all the data (even the data not shown) can be saved
by pressing Save to File.
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6. Record where the Snapshot File gets saved.
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7. Print the Snapshot from the file menu.

8. Once saved, the Snapshot file can be Exported to MS Excel by pressing the Export option
in the File menu.

9. To Export, the file just saved needs to be opened again.
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10. The exported file can be saved as an .XLS file

11. A confirmation dialog gives the option to change file names.

12. Record where the file was saved.

13. The Snapshot can be opened in Excel.
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14. The excel file should appear like to picture below:

15. The additional Snapshots can be accessed by pressing the Snapshots... button in CatET.
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16. Repeat this Snapshots section for all the available Snapshots.

9.3.5 Preserving ECM Date and Time

1. Select ECM Date/Time from the Service Menu.

2. Open the PC System Clock and press the PrntScrn key on the PC keyboard.

3. Paste (Ctrl-v) the captured graphic into Paint or MS Word.

4. Save the document with the screenshot.
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9.4 Forensic Write Blocking

There are certain messages that should not be transmitted to the ECM during a forensic
examination. These messages are the kind that will change the data stored on the ECM in a
meaningful way. Resetting or clearing fault codes, changing the ECM time, and resetting trip
data should always be avoided.

The following messages are actively filtered and blocked by the Forensic Link Adapter. The
Forensic Link Adapter will not transmit these messages to the ECM.

Message Purpose

Time Reset Prevent the ECM RTC from being reset.
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10

Verifying Data in the Field

The FLA is able to give the user an overview of the data collected in the field through the
FLA Preview. The FLA Preview is a website generated by the FLA that allows the user to
connect to the device and examine data on it.

10.1 Accessing the FLA Preview

There are two ways to access the FLA Preview depending on what is available. If a good
Ethernet port is available, connect using the at-home/in-office method. If no Ethernet port is
available, connect to the preview using the in-field method.

10.1.1 At-Home/In-Office

If the operator is in an office, or at home, they can set the FLA up for home use, section 4.2,
or for office use 4.1. Enter the IP address from the title screen into a web browser. This will
take you to the FLA Preview website. If you have trouble accessing the preview, refer to the
troubleshooting section.

10.1.2 In-Field

The first step in accessing the FLA Preview is to have the FLA in the correct mode. Unless
the operator wishes to place the FLA in support mode, the easiest way to access the FLA
Preview is to set up the FLA for the field, as described in section 4.3. Once the FLA has
DHCP enabled, and the computer is directly connected to the FLA with the Ethernet cable,
enter ”10.0.0.1” into a web browser. This will take you to the FLA Preview website.
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10.2 Using the FLA Preview

The main page of the FLA will show the user how many pending data packages there are
on the FLA, as well as if there are any downloads in progress. Under the View Local Data page,
the operator can view the data packages that are not yet uploaded to the Synercon Server.

This page gives a brief overview of each data package on the FLA that is not yet uploaded.
The OEM data column indicates if the FLA has extracted data from the engine that is not a
part of the standards-based extraction. From this page the operator can view the data from an
individual data, view archived data packages, or archive pending data packages.

Archiving a pending data package will move the data package to the archived list,
and it will NOT be uploaded to the server. This is only to be used when the operator
has a pending data package they do not want to upload on the server, i.e. if it was a practice
download, or it contains incomplete data due to a lose cable. Use this with care, archived data
packages cannot be un-archived without Synercon support.

The View Data button will allow the operator to view a preview of the report. This will
contain all of the standards-based messages, as well as standards-based faults. If the FLA
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was able to collect non-standards-based data a portion of the decoded data will be available for
download. The full records will be available once the operator uploads the data to the Synercon
Portal.

The operator can also view archived data with the button at the bottom. Note, the archived
page can take some time to load.

Under each report, the user can download the SHA256 Sums
file. This file contains the SHA 256 sums of all of the files the
FLA generated at the time of the download. These sums are
cryptographic fingerprints of the files that can be used to deter-
mine if the file has changed since the FLA created the file. The
user can save this file to perform verification of integrity of data obtained. For more information
about SHA256 sums, refer to section 6.2.6.
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11

Administrator’s Guide

This section is intended to teach administrators how to manage FLAs on the FLA Portal.

11.1 FLA Portal terminology

The FLA Portal has the following categories:

Organizations are the top level with a site administrator as the person in charge. Typically
this is a highway patrol, a state police, or a company. The person in charge of the
organization has the ability to oversee the data and use of the different FLAs.

Groups are a sub-level within an organization. For example, East District and West District
may be groups within an State Police organization. If an organization only has a few
operators and a few FLAs, it may not make sense to have different groups.

Operators are trained users of the FLA and are responsible for collecting data in the field.
Operators can be assigned to different groups. Every operator in the group is able to see
the data packages from all the FLAs assigned to the group, regardless of which operators
downloaded the data.

Forensic Link Adapters are the hardware devices that an organization owns.

11.2 Account Overview

Forensic Link Adapters are assigned to each organization at the time of purchase. Once
the organization completes the purchase, the serial numbers of each FLA will be loaded into
the Organization’s profile. An invitation to set up the Organization will be sent to the site
administrator. For example, the Lieutenant in charge of the crash reconstruction division will
become the site administrator once he or she registers by following the link sent in the invitation
e-mail.

Once logged in as a Site Administrator, an account overview page will be available, much
like the one shown in Figure 11.1. Many of the fields on the web page are linked to various
functions. The top bar (in black) has links to your default login page, the latest FLA download
if you are an operator, a list of all the organizations, FLAs, and some account access settings.
The web page is set up in three distinct tables as seen in Figure 11.1.

1. Organization Groups
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Figure 11.1: Example Forensic Link Adapter Portal web page for the Account overview

2. FLA Operators

3. Forensic Link Adapter (FLA)

11.3 Group Management

It is the responsibility of the Organization administrator to set up groups and operators ac-
cording to the desired structure of the Organization. You can have operators that have access
to more than one group.

11.3.1 Adding an Operator

There are two ways to get an operator access to the group’s FLAs. The first is to invite a new
operator and the second is to invite an existing operator. However, the existing operator must
have accepted an invitation from the Organization under a unique e-mail address. By clicking
on the lower left box the says Invite new operator shown in 11.2, a web page similar to the
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Figure 11.2: Example Group Details web page from the Forensic Link Adapter Portal.

one shown in 11.3. The required user information includes name and email address. The FLA
portal uses e-mail addresses to identify operators. Therefore, if a person belongs to different
organizations, they would have to use a different e-mail for each organization. New operators
will get an e-mail from fla-admin@synercontechnologies.com with a link to register with
the site. Many times this e-mail will be filtered as junk, so advising the recipient to check their
e-mail filters and junk folder may be necessary.

The Work Address details on the Invite and operator page are used to fill in a report with

11.3.2 Assigning an FLA to the Group

Each group needs to have at least one Forensic Link Adapter assigned to it. To assign an FLA
to a group, click the button to see a list of available FLAs for your organization. Only people
in the group can see the data on the FLA assigned to that group
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Figure 11.3: New Operator invitation form on the FLA portal website.

73



Figure 11.4: Assigned FLAs
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12

Suggested Practices

This section is intended to provide a very brief overview of using the FLA, for a more in-depth
guide, refer to the Field Guide.

12.1 Initiating FLA Support mode

In order to provide the quickest and most complete support, it may be necessary to place the
FLA in support mode. This allows Synercon Support staff to create a secure connection to an
FLA anywhere with an Internet connection. It may also be referred to as a “Support Channel”.

To place the FLA in support mode, or “Open a Support Channel”, follow these steps

1. Verify a Synercon Support representative is ready for you to initiate Support Mode.

2. Connect the FLA to the Internet as described in subsection 3.3.3.

3. Navigate to the FLA Preview site as described in section 5.

4. Select the “Support” option from the menu at the top.

5. Click the “Open the support channel” button to initiate Support Mode.

6. After a brief period, the page will change to say the connection was successful, if the
connection was not successful, refer to the troubleshooting section.

7. Do not close the web page, or click the “Back” or “Refresh” buttons. It is important to
stay on this page until the Synercon Support representative is finished providing support.

8. When the Synercon Support representative begins working on your FLA, the screen on
the device will change to indicate a member is performing work.

9. When the Synercon Support representative is finished, the unit will display a message
indicating the work is finished.

10. The FLA will automatically reboot.

11. After the device loads the Title Screen, then click the “Close Support” button to return
the FLA to normal operational mode.
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12.2 Installing PC Software

12.2.1 RP 1210 Drivers

The FLA can operate as an RP1210 device. This is used for connecting OEM software to
ECMs. A computer does not need the RP 1210 drivers to access the FLA Preview, and the
FLA Portal. You will need administrative privileges to install these drivers.

To install the RP1210 Drivers, follow these steps

1. Connect to the FLA Preview described in the above section (Either In-Field, or In-Office
methods will work)

2. Select the Download Drivers option from the menu at the top of the web page

3. Select “Download Drivers”

4. Once the file is downloaded, extract the .zip file to a folder

5. Open the folder, and double-click “DPA4Plus RP1210.exe”

6. Follow the on-screen instructions to install the drivers

After the drivers are installed, they can be tested with the following steps

1. Make sure the FLA is powered on, and connected to an ECM (It is possible to test the
drivers without a live ECM, to do so see the special instructions)

(a) Skip steps 2,3,and 4 if not connected to a live ECM

(b) Begin a scan on the vehicle

(c) After the scan has completed and you see the ”Enable RP1210 Mode” screen

(d) Confirm the top line of the FLA read ”CAN/J1939 Pass Mode.”

(e) Search on your computer for the program ”Adapter Validation Tool” and run it

(f) Select ”MD/HD”

(g) Set the Vendor to ”DG1210xx - Dearborn Group RP1210” (the xx will likely be 32)

(h) Set the Device to ”DG DPA 4 Plus USB”

(a) Skip to step 14 if the ECM does not support J1939

2. Set Protocol to ”J1939”

3. plug the USB cable into the FLA and the computer

4. Click ”Run Test”

5. The text boxes labeled ”RP1210 Status Window (PC-VDA)” and ”RP1210 Data Message
Window (VDA-Vehicle)” should turn green

(a) If you are not connected to a live ECM, the ”RP1210 Data Message Window” will
turn red as there are no messages

6. A text box will appear and will describe the results of the test.
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7. Click ”Quit” on the pop-up window titled ”Test Results Discussion”

(a) If the ECM does not support J1708, the test is complete.If it does, continue

8. Change the protocol to J1708

9. On the FLA click the Green button to enable J1708 passthrough

10. Confirm the top line of the FLA read ”J1708 Pass Mode for”

11. Click ”Run Test”

12. A text box will appear and will describe the results of the test

13. Click ”Quit” on the pop-up window titled ”Test Results Discussion”

14. Close out of the adapter validation test

12.3 Performing a download on a Heavy Vehicle

This section provides a very high level overview of a typical download.

1. Plug in the FLA to the 9-Pin Diagnostics Connector

2. Turn on the ignition key to run

3. Run a vehicle Scan

4. Download Supported Data (if available)

5. Enable RP1210 Mode (Optional depending on the ECM and user’s procedure)

(a) Connect the USB Cable

(b) Run OEM Software

6. Verify the data collected via the FLA Preview

(a) If desired, repeat steps 3-6 until satisfied

7. Shutdown the FLA

8. Reach a location that has a working Ethernet port

9. Connect the FLA to the Internet

10. Upload the data from the field

11. View the full report on the FLA Portal
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12.4 Connecting to Engine Control Modules on a Bench

When performing bench downloads, it is recommended to use a Smart Sensor Simulator to min-
imize the chance of throwing additional faults as compared to a traditional calibration harness.
For more information about Smart Sensor Simulators, visit \url{synercontechnologies.com}.
Once connected, use the FLA in accordance to the recommended practices outlined in the
Field Guide and accompanying Quick Start guides.

The following are typical steps taken during a download.

1. Confirm the correct SSS is being used for the ECM

2. Connect the SSS to the ECM

3. Connect power to the SSS via the included power adapter

4. Press the Key Switch until the Key On lamp is illuminated, about two seconds

5. Verify the Key On lamp stays illuminated for one second before proceeding. If not, refer
to the troubleshooting section

6. Plug in the FLA to the 9-Pin Diagnostics Connector located on the SSS

7. Run a vehicle Scan

8. Download Supported Data (if available)

9. Enable RP1210 Mode (Optional depending on the ECM and user’s procedure)

(a) Connect the USB Cable

(b) Run OEM Software

10. Verify the data collected via the FLA Preview

(a) If desired, repeat steps 3-6 until satisfied

(b) Skip to step 13 if there is a working Ethernet port where the bench download is
occurring

11. Shutdown the FLA

12. Reach a location that has a working Ethernet port

13. Connect the FLA to the Internet

14. Upload the data from the field

15. View the full report on the FLA Portal
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Part III

General Information
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13

Troubleshooting

13.1 Vehicle Connection Problems

13.1.1 Do not get the Option to Scan Vehicle

Symptom:

The FLA Title Screen does not allow the
user to scan the vehicle

Solution:

Check that the key is in the ON position, with the engine not running.

Check to see if the vehicle voltage is nominal, low voltage may prevent ECMs from
responding.

Check all cables for secure connections.

If the above list does not solve the issue, the communication wires from the ECM to the
diagnostic port may be damaged. If this is the case, the ECM modules may have to be removed
and the operator may have to perform a bench download on the unit. The recommended
practice is to use a Synercon Smart Sensor Simulator with the truck ECMs in order to help
preserve the data on the modules.

13.2 FLA Internet Problems

13.2.1 Cannot access the FLA Preview website

Symptom:
The operator is not able to access the FLA Preview website. Solution:
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navigate to the title screen and verify the FLA has an IP address. If the IP line reads
’cable unplugged’, or ’finding IP address’, see the FLA Does not have an IP Address
section.

If the FLA is not connected directly to a computer (i.e. the FLA is plugged into an
Ethernet port in an office, or home) ensure the DHCP service is off. If the IP address
of the FLA is 10.0.0.1, the DHCP service is likely on. For more information about the
DHCP service, see section 3.3.7.

Ensure the operator has typed in the IP address exactly as it appears on the FLA, do not
add any extra characters, such as leading zeros before the numbers, or extra spaces.

Correct:

Incorrect:

Ensure the FLA is on the same network as the computer used to access it. Depending on
the configuration, if the computer is connected to a wireless network, try to plug into an
Ethernet cable near the port the FLA is plugged into.

If the above steps do not resolve the problem, the operator may need to contact the department
IT services. If they are not able to resolve the issue, please contact Synercon support.

13.2.2 FLA Does not Have an IP Address

IP says Ethernet Unplugged

Symptom:

The IP line of the FLA Title screen says
Ethernet Unplugged
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Solution:

Check cables are plugged in all the way.

Reboot the FLA with the Ethernet cable plugged in.

Verify the port is working with a computer.

Contact your department IT services, and ensure the FLA is given the permissions to
access the Internet. Often this is done by ’whitelisting a MAC address’. If the operator
needs to provide the MAC of the FLA, this can be accessed via the configuration menu.
For more information, see section 3.2.2.

If the above steps do not solve the issue, the operator may need to contact Synercon support.

IP says Finding IP Address

Symptom:

The IP line of the FLA Title screen says
Ethernet Unplugged

Solution:

If the FLA is being used in the field, and directly connected to a computer, enable the
DHCP service. See section 3.3.7.

Reboot the FLA with the Ethernet cable plugged in.

Verify the port is working with a computer.

Contact your department IT services, and ensure the FLA is given the permissions to
access the Internet. Often this is done by ’whitelisting a MAC address’. If the operator
needs to provide the MAC of the FLA, this can be accessed via the configuration menu.
For more information, see section 3.2.2.

13.3 FLA Boot Problems

13.3.1 FLA Does not Boot When Plugged in

Symptom:
The FLA does nothing when plugged into a vehicle. Solution:

The power wires to the diagnostic port may have been damaged, use the cigarette lighter
adapter in the FLA case to provide power to the FLA. It is recommended to carry a
portable battery for powering the FLA via battery for such situations.
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If the FLA will not boot with either the cigarette lighter adapter plugged into a know charged
battery, or the wall adapter, please contact Synercon support.

13.3.2 FLA Does not finish booting

Symptom:

The FLA reaches this screen, and does not
proceed to the Title screen for more than
30 seconds.

Solution:

Wait 30 seconds for the system to attempt to boot.

If the system does not boot, remove power sources, wait 30 seconds and then plug the
FLA in. Note this is not recommended as a standard method to shut the FLA down, only
do this when you have exhausted all other methods to shut the system down safely.

If the device continues to fail to boot for more than 2 times, please contact Synercon support.
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14

Definitions

When dealing with heavy truck data, there are many acronyms, symbols and phrases that are
used to describe the data. This chapter presents a list to help decipher some of the terms used
for dealing with heavy vehicle event data recorders.

The Forensic Link Adapter (FLA) is a field rugged computer that is programmed to down-
load data from heavy vehicles.

ECMs: Electronic Control Modules. These are the “computers” that run heavy vehicles, they
can contain data useful when investigating a heavy vehicle.

OEM Original Engine Manufacturer.

The FLA the data extraction device device created by Synercon. This is the blue box that
the operator uses to communicate with heavy vehicles.

The FLA Portal the website fla.synercontechnologies.com . This is where operators can view
full reports

The FLA Preview the local website hosted by the FLA. This allows operators to preview
reports before they are uploaded to the FLA Portal.

Data Package all of the data extracted from a heavy vehicle, as well as metadata about the
extracted data, such as GPS coordinates, and timestamps.

Preview Report a report that has not been processed by the FLA Portal, these reports only
have standards-based data, and some of the non-standards-based data.

Full Report a report that is being viewed from the FLA Portal, these reports will have all of
the data the FLA system is able to understand.

Standards-based-data Data that is defined by the SAE standards J1587 and J1939.

Non-Standards-based-data Data that is not defined by the SAE standards J1587 and J1939.
i.e. Snapshot records for CAT ECMs. These data elements are determined by the OEM
of the ECMs

NIST National Institute for Standards and Technology (http://www.nist.gov/)

RTC Real Time Clock
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15

Requirements

In order to take full advantage of the Synercon products, such as the FLA, FLA Preview, and
FLA Portal, the user will need to have access to additional software and ports such as those
outlined in the following sections.

15.1 Supported Web Browsers

In order for the FLA Preview and FLA Portal to work correctly, the user will need to meet
the following browser requirements.

Internet Explorer at least version 10 (2012)

Firefox at least version 31 (2012)

Chrome at least version 31 (2013)

Safari at least version 7 (2013)

Opera at least version 29 (2015)

15.2 Drivers

In order to use the FLA in RP 1210 mode, the operator will need to install the drivers first.
This will require administrative privileges. The drivers are provided with the FLA.

15.3 OEM Software

In order to extract data from ECMs that are not fully supported, the operator will need the
relative OEM software to acquire non-standards-based data.
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16

Warnings

Synercon Technologies does not warranty any products against user caused problems. In
order to prevent any damage to the FLA and data collected by the FLA, always follow these
guidelines.

Only use the included wall adapter or cigarette adapter to power the FLA

When not using a vehicle to power the FLA, only power the device using the included power
supplies. Never plug in a foreign adapter, especially if the voltage exceeds 12 volts.

Never plug the FLA into a diagnostic port that has a vehicle voltage above
26 volts

When plugging in the FLA to a vehicle, ensure the voltage of the diagnostic port does not
exceed 26 volts. If in doubt, a multi-meter can be used to verify voltage

Do not remove power from the FLA without first shutting down

Unless specifically instructed to do so by a troubleshooting guide, avoid removing power to the
FLA without first shutting down. Use the securing screws of the cables to secure all cables
against accidental disconnection.

Do not expose the FLA to water

The FLA is NOT waterproof, even powered off. Avoid dropping the unit in puddles, or exposing
the device to rainfall. Take care to ensure a dry environment is available before operating the
FLA. If the unit is exposed to water, even when powered off, the water can damage the unit,
and potentially any data stored on the unit. If exposed to water, immediately power the unit
off and contact Synercon Support for instructions.

Do not expose to excess heat or cold

Do not expose the FLA to temperatures exceeding 50C (122F), or below 0C (-32F).
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17

Synercon Training

Synercon Technologies provides classes to train users in the proper use of Synercon Prod-
ucts in investigating vehicles. For more information about classes, please contact jeremy@

synercontechnologies.com.

18

Contact Synercon Technologies

Sales

If you need to extend an extending an FLA subscription, or are interested in purchasing addi-
tional FLAs, or SSSs, please contact our sales department at email{sales@synercontechnologies.com}

Support

While we strive to provide the highest quality products, if you have an issue with our products
and need to contact us, please send an email to \email{support@synercontechnologies.com}.

When requesting support, please include the following:
1) the product (i.e. FLA, or SSS)
2) the serial number (it is printed on the bottom of all Synercon Products)
3) A detailed explanation of the issue
4) Any steps you have already taken to solve the issue
5) [optional] any screen shots, or pictures if you believe they will help us understand the

problem.
We will attempt to respond to you as quickly as possible.
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